[image: image2.png]4% Windows




An Introduction to How to Build, Install, Test, and Debug KMDF Drivers - 14

An Introduction to How to Build, Install, Test, and Debug KMDF Drivers
April 6, 2007
Abstract

This paper is an overview of how to build, install, and debug kernel-mode driver framework (KMDF) drivers for the Microsoft® Windows® family of operating systems.
This information applies for the following operating systems:

Windows Vista™

Windows Server™ 2003

Microsoft Windows XP

Microsoft Windows 2000

The current version of this paper is maintained on the Web at: 

http://www.microsoft.com/whdc/driver/wdf/KMDF-build.mspx
References and resources discussed here are listed at the end of this paper.
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Introduction
Microsoft® Windows® drivers have, for many years, been based on the Windows Driver Model (WDM). WDM drivers have a well-deserved reputation for being difficult to implement correctly, and developers face a steep learning curve when they enter the driver world. The time and effort that is required to master WDM has made it largely the domain of a relatively small group of specialists.
The Windows Driver Foundation (WDF) is designed to make drivers much easier to implement and much harder to implement incorrectly. The simpler and more robust programming model that is supported by WDF makes the transition from application developer to driver developer much easier than with WDM. In particular, WDF provides default handling for Plug and Play and power management events, which substantially reduces the size and complexity of WDF drivers compared to equivalent WDM drivers. It also largely eliminates what has historically been a significant source of driver bugs.
WDM can be used only to implement kernel-mode drivers. One of the goals for WDF is to allow a much broader range of devices to be supported by user-mode drivers. For that reason, WDF has two components: the kernel-mode driver foundation (KMDF) and the user-mode driver foundation (UMDF) for kernel-mode and user-mode drivers, respectively.
The first step in implementing a WDF driver is deciding which type of driver is better suited for your purposes. UMDF drivers cannot perform operations such as handling interrupts, performing direct memory access (DMA) operations, or using kernel-mode resources such as the nonpaged pool. Drivers that need such features must be implemented with KMDF.
If you decide to implement a KMDF driver, this white paper is meant to get you started by describing the basics of how to build, install, and debug such drivers. It is especially intended for application developers with no prior driver experience, but it should be useful to anyone who is new to KMDF. 
However, before going any farther:
· If you are completely new to drivers, you should first familiarize yourself with the basics of Windows driver development. A good starting point is “Introduction to Kernel-Mode Driver Development for Application Developers” on the WHDC Web site.
· For comprehensive information about writing WDF drivers, see Developing Drivers with the Windows Driver Foundation, by Penny Orwick and Guy Smith, available at http://www.microsoft.com/MSPress/books/10512.aspx.
How to Obtain KMDF
The tools and documentation for implementing KMDF drivers are included with the Windows Driver Kit (WDK). They include:

· Header files
· Libraries

· A redistributable co-installer

· Sample code

· Development tools

· Documentation

The WDK files are usually installed under a top-level folder on the C drive that is named WinDDK. Each WDK build goes under a subfolder of WinDDK that is named with its build number. For example, the version of the WDK that was released with Windows Vista™ is typically found at C:\WinDDK\6000.
The latest release of KMDF is version 1.5, which is included with the Windows Vista release of the WDK. The KMDF runtime is native to Windows Vista and can be installed on Windows 2000, Windows XP, and Windows 2003 server. Version 1.5 supersedes versions 1.0 and 1.1. It is completely backward compatible with the earlier versions and should be used for all KMDF development efforts.
You should always use the most recent version of the WDK to implement your drivers. It is backward compatible with earlier versions and contains the latest versions of tools and documentation, as well as any bug fixes that have been made since the previous release. For instructions on how to download the WDK, see “How to Get the Windows Driver Kit (WDK) and the Windows Logo Kit (WLK)” on the WHDC Web site. 
How to Build a KMDF Driver

Although KMDF supports a completely new DDI and programming model, the basic process of implementing and building a KMDF driver still has much in common with WDM. If you are new to driver development, here are a few key points.
· Drivers are normally written in C. C++ can be used for driver development in only a very limited way. You can safely use some basic C++ features like inline variable declaration, but the object-oriented features of C++ produce generated code that is not guaranteed to work correctly in kernel mode.
· You can use a .cpp extension and the C++ compiler to compile driver code. The C++ compiler works fine with C code and provides better error detection and type safety than the C compiler.

· Include Ntddk.h and Wdf.h. These are standard header files that are used for all KMDF drivers.

· Drivers must be built with the WDK or DDK build tools. Microsoft Visual Studio® is not designed to support driver development and can be used in only a limited way.
The remainder of this section goes through the basics of how to use the WDK build tools to build a KMDF driver.

The WDK Build Tools

KMDF drivers are built with the WDK build utility, build.exe, a command line tool that is essentially identical to the tool that is used to build Windows itself. The build utility can be used for a variety of project types including user-mode applications, but it must be used for drivers. This section provides a basic introduction to the build utility. For further information, see the WDK documentation.
The build utility requires a number of supporting files. The following are required for any project:

· Source code files. A project must have at least one source code file (.c or .cpp) and typically one or more header files (.h).
· Make file. This file contains build instructions. It should be named makefile and consist of the following statement that includes the standard WDK make file.
!INCLUDE $(NTMAKEENV)\makefile.def

· Sources file. This file contains project-specific information that is used to build the driver, such as the list of source files. The following example shows the contents of a basic Sources file. An example of a somewhat more complex Sources file along with an explanation of its elements is given in "How to Build Featured Toaster," later in this paper.

TARGETNAME=WdfSimple

TARGETTYPE=DRIVER

KMDF_VERSION=1

SOURCES=WdfSimple.c
Optional files include:

· Makefile.inc. Project with custom targets, such as WMI-related files, must put the necessary directives in Makefile.inc. Do not modify the standard make file.
· Dirs. This file is used by projects that have source files in multiple subfolders or to build multiple projects with a single build command.

· Resource files (.rc). These files contain resources such as string tables.

· Managed object format (MOF) resource files (.mof). Drivers that support Windows Management Instrumentation (WMI) must have a MOF resource file (.mof).

· INX file (.inx). An INX file is an architecture-independent INF file. When the appropriate instructions are specified, the Build utility uses the data in an INX file to produce an appropriate INF file for the project. 
You can use any names that are convenient for most project files and folders, with one important restriction: the names cannot contain spaces or non-ANSI characters. However, the build utility assumes by default that the make, makefile.inc, Sources, and Dirs files are named makefile, makefile.inc, sources, and dirs, respectively.
The supporting files must all be created manually. However, you can usually simplify the process by copying the files from an appropriate sample and modifying them to suit the project. For complete details on the format and contents of these files, see the WDK.
Visual Studio can be used in only a limited way for driver development. In particular, its compiler and debugger are not designed to be used with drivers. However, if you are accustomed to using Visual Studio, you can still use its integrated development environment (IDE) to edit source code and build the driver. Essentially, you reprogram the Visual Studio Build command to bypass the Visual Studio build utility and instead run a command line that launches the WDK build utility. You still must manually create the build utility supporting files that were discussed earlier in the section.

The Build Environment

There are two basic types of build:

· Checked builds are similar to the Debug builds that are used in application development. They generate detailed debugging information and enable certain types of debugging-related code such as ASSERT macros. Checked builds are normally used during the earlier stages of driver development because they are much easier to debug than free builds. Checked builds are typically somewhat slow.
· Free builds are similar to the Release builds that are used in application development. They lack the detailed debugging information of a checked build and are fully optimized. Free builds are more difficult to debug, so they are typically used at the end of the development cycle for final testing and performance tuning.

To simply the process of setting up the build environment, the WDK includes a set of console windows with the correct settings for each build environment/platform/architecture combination. 
To open a build environment window:
1.
On the taskbar, click Start, and then click All Programs.

2.
Click Windows Driver Kits, click the latest WDK version, and then click Build Environments.

3.
Click the appropriate CPU architecture, and then open a checked or free build environment window for the appropriate Windows version.

The build environment window for a specified version of Windows works for that version and all later versions.

Note  To run WDK tools on Windows Vista, you must open the build environment window with elevated privileges.
How to Build a Project

After you have launched the correct build window, use cd to move to the project folder and run the build utility to compile and link the driver. The command syntax is simple:

build -a[b[c]...]
The build utility assumes by default that the project has a make file that is named makefile, a Sources file with the list of source files, and so on. There is no need to specify these files explicitly. a[b[c]...] represents the build arguments, most of which consist of a single case-sensitive character. The WDK has a complete list of flags, but here are some of the commonly used ones:
· ?. Display a list of all command-line flags.

· c. Delete all object files.

· e. Generate log, error, and warning files.

· g. Use colored text to display warnings, errors, and summaries.

· Z. Prevent dependency checking or scanning of source files.

The following example shows a commonly used build command.


build -ceZ

The build utility produces several output files, including:
· TargetName.sys: The driver binaries.

· SourceFileName.obj: Object files that are produced from the corresponding source files.

· TargetName.pdb. The driver's symbol tables.

· TargetName.inf. The project's INF file. This file is produced by the build utility only if the project uses an INX file. Otherwise, you must create the INF file separately.

The output normally goes in a subfolder of the project folder. The default output folder name depends on the build environment. For example, the default output folder for a Windows XP x86 free build is named ProjecFolder\objfre_wxp_x86\i386.
How to Build Featured Toaster

The Toaster sample is a set of simple software drivers that were created by Microsoft as a learning tool for new driver developers. If you are new to KMDF driver development, it's the first sample you should look at. Not only does Toaster provide a simple example of how to write drivers by using the best coding practices, it includes detailed comments that explain every step. Toaster is located at WinDDK\BuildNumber\src\kmdf\toaster.

Toaster includes a number of drivers, including two function drivers. One is a minimal version that is named Simple and the other a full-featured version that is named Featured. This white paper uses the Featured Toaster sample as a convenient way to demonstrate the basics of the build, install, and debug process. This section is a walkthrough of how to create a Windows XP checked build of Featured Toaster. It discusses the details of some of the supporting files that are mentioned in the previous section.

Note  The KMDF version of Toaster is essentially a port of the WDM Toaster sample. If you are familiar with the WDM version, compare it to the KMDF version to see just how much KMDF can simplify driver code.
Makefile and Makefile.inc
The contents of Makefile are the same for all driver projects, as discussed earlier in this paper. Featured Toaster also includes an optional file, Makefile.inc. This file contains some additional make directives that handle two targets that aren't covered by makefile.def. The following example shows the contents of Featured Toaster's makefile.inc file.
_LNG=$(LANGUAGE)

_INX=.

STAMP=$(STAMPINF_PATH) -f $@ -a $(_BUILDARCH) -v 1.0.0.0

$(OBJ_PATH)\$(O)\$(INF_NAME).inf: $(_INX)\$(INF_NAME).inx

        copy $(_INX)\$(@B).inx $@

        $(STAMP)

mofcomp: $(OBJ_PATH)\$(O)\toaster.bmf

$(OBJ_PATH)\$(O)\toaster.bmf: toaster.mof

        mofcomp -WMI -B:$(OBJ_PATH)\$O\toaster.bmf toaster.mof

        wmimofck -m -h$(OBJ_PATH)\$O\ToasterMof.h -w$(OBJ_PATH)\$O\htm $(OBJ_PATH)\$(O)\toaster.bmf

The first part of makefile.inc uses the project's INX file, wdffeatured.inx, to produce an architecture-specific INF file. The second part of makefile.inc produces the WMI target files.
The Sources File

The Sources file contains most of the project-specific information that the build utility uses to build the project. It consists of a series of directives that assign project-specific values to a set of macros and environment variables. The following example shows the contents of the Featured Toaster Sources file, which is a typical Sources file for a simple KMDF driver.
TARGETNAME=wdffeatured

TARGETTYPE=DRIVER

KMDF_VERSION=1.5
INF_NAME=wdffeatured

MISCFILES=$(OBJ_PATH)\$(O)\$(INF_NAME).inf

INCLUDES = $(INCLUDES);..\..\inc;..\shared

NTTARGETFILES=

NTTARGETFILE0=mofcomp

#

# List of source files to compile.

#

SOURCES=            \

        toaster.rc  \

        toaster.c   \

        power.c   \

        wmi.c

C_DEFINES=

!include $(WDF_ROOT)\project.mk

The following list gives brief descriptions of the macros and environment variables in this file. For a complete list, see the WDK documentation.
· TARGETNAME. Required. This macro specifies wdffeatured as the name to be used for output files such as the project's .sys and .pdb files.

· TARGETTYPE. Required. The build utility can be used to build a variety of binary types. This macro specifies which type of binary is to be built. DRIVER indicates a kernel-mode driver.

· KMDF_VERSION. Required. This environment variable specifies the KMDF version number. This project uses KMDF version 1.5.
· INF_NAME. Optional. INF_NAME is a custom macro for projects that use INX files. It specifies that the INF file that is generated from the projects INX file is to be named wdffeatured.inf.
· MISCFILES. Optional. MISCFILES is a custom macro for projects that use INX files. It specifies where to place the INF file that is generated. In this example, the INF file is placed in the output folder with the other output files.
· INCLUDES. Optional. This macro specifies the location of folders, other than the project folder, that contain header files. These are typically header files that are shared across multiple projects.

· NTTARGETFILES. Required. Indicates that the project has a Makefile.inc file. No value is specified in the example. Instead, the output folder is specified by INF_NAME.
· NTTARGETFILE0. Optional. This macro is used to specify additional targets and dependencies that are not covered by makefile.def. In this case, it is used for the WMI-related aspects of the build.

· SOURCES. Required. This macro lists the project's source files. By default, the files must be on a single line. The backslash (\) is a line-continuation character that allows the files to be listed on separate lines.
· C_DEFINES. Required for Unicode builds. Specifies any compile-time switches that must be passed to the C compiler. 
The Build
The following procedure shows how to build Featured Toaster. For simplicity, assume that the WDK's root folder is C:\WinDDK\6000.
1. 
Launch the Windows XP Checked Build Environment console window. It opens in the c:\WinDDK\6000 folder.
4. 
Use cd to move to the project folder, C:\WinDDK\6000\src\kmdf\toaster\func\featured.

5. 
Build the project by running the following command. This isn't the only way to build the project, but it's a commonly used set of flags.

build -ceZ

The output files go in the featured\objchk_wxp_x86\i386 subfolder.

How to Install a KMDF Driver

Drivers must be installed before they can be used—either by the developer to test and debug the driver or by the end user who wants to use the related device. The procedures for installing a driver are distinctly different from those that are used to install applications. This section discusses how to create a WDF installation package and install it on a system.

There are a variety of ways to install a driver on a user's system. One common way is users to simply attach the associated hardware to their system. The Plug and Play manager detects new hardware and prompts the user to insert a disk that contains the driver package. The system then installs the driver. Users can also install drivers manually with the New Hardware application in Control Panel.
KMDF driver packages contain at least three files in addition to the driver binaries:
· The KMDF co‑installer dynamic-link library (DLL).
· An INF file.
· A digitally signed catalog (.cat) file. This file is not necessary for test installations.
Driver packages can optionally contain files such as icons, property sheet providers, supporting DLLS, and so on. This white paper discusses the relatively simple driver package and test-installation procedure for Featured Toaster. For further information, see the WDK documentation.

The WDF Co‑installer

A KMDF driver package must include the redistributable WDF co‑installer DLL. Its primary purpose is to install the KMDF runtime. The WDF co‑installer is located under the WinDDK\BuildNumber\Redist\Wdf folder. There are six co‑installers: a checked and a free build for each supported processor architecture (x86, Intel Itanium, and amd64). To install the WDF co‑installer, add the appropriate DLL to the driver package and add the appropriate directives to the INF file, as discussed in the next section.
Note  The WDF co‑installer version number must be greater than or equal to the KMDF version with which the driver is compiled. The version number is embedded in the DLL's name. For example, the co‑installer for KMDF version 1.5 is named WdfCoInstaller01005.dll. The KMDF runtime version and the KMDF co‑installer version that are specified in the project's INF must be identical.
Important  The build type of the co-installer must match that of the Windows version on which the driver will be installed. You cannot use the checked build of a co-installer to install a driver on a free build of Windows, or vice versa.

The INF
The INF is the core of the installation package. It is a text file that contains most of the information that the system uses to install a driver, including:
· General information about the device such as the device’s manufacturer, installation class, and version number.

· Names and locations of files on the distribution disk and where they should be installed on the user’s system.

· Directives for creating or modifying registry entries for the driver or device.

· Installation directives for which drivers are to be installed, which binaries contain the driver, and a list of drivers to be loaded on the device.

· Directives for setting KMDF-specific configuration information.

The INF format is much like the earlier Windows .ini files. Each line contains a single entry, and there are two basic types of entries:

· Section. Each INF contains a number of sections, indicated by square brackets, for example, [Version].

· Directive. Each section contains one or more directives. A directive is a key-value pair and is used to specify various types of installation-related data. For example, the Class=Mouse directive in the Version section specifies the mouse device class.

INFs for KMDF Drivers

Most of the contents of an INF for a KMDF driver are similar to those that are used for WDM drivers and aren't discussed here. For further information, see the WDK documentation or examine the INF for Featured Toaster, wdffeatured.inf. The major difference is that INFs for KMDF drivers must contain several additional sections that are devoted to the KMDF co‑installer. These sections instruct the system to run the co‑installer and provide it with necessary data. The co‑installer unpacks and installs a number of files that KMDF drivers require, including the KMDF runtime library.
WdfFeatured.inf

The following sample shows the WDF co‑installer sections from the Featured Toaster sample's INF file, wdffeatured.inf. It was produced from an INX file by the build described earlier.
[DestinationDirs]

ToasterClassInstallerCopyFiles = 11

[Toaster_Device.NT.CoInstallers]

AddReg=Toaster_Device_CoInstaller_AddReg

CopyFiles=Toaster_Device_CoInstaller_CopyFiles

[Toaster_Device_CoInstaller_AddReg]

HKR,,CoInstallers32,0x00010000, "WdfCoinstaller01000.dll,WdfCoInstaller"

[Toaster_Device_CoInstaller_CopyFiles]

WdfCoinstaller01000.dll

[SourceDisksFiles]

WdfCoinstaller01000.dll=1
[Toaster_Device.NT.Wdf]

KmdfService = wdffeatured, wdffeatured_wdfsect

[wdffeatured_wdfsect]

KmdfLibraryVersion = 1.1
To modify this code for your driver, replace the text that is specific to Featured Toaster with custom text of your choosing. The following example is a generic version of the co‑installer section for a driver that is named MyDevice:
[DestinationDirs]

MyDeviceClassInstallerCopyFiles = 11

[MyDevice.NT.CoInstallers]

AddReg=MyDevice_CoInstaller_AddReg

CopyFiles= MyDeviceClassInstallerCopyFiles

[MyDevice_CoInstaller_AddReg]

HKR,,CoInstallers32,0x00010000, "WdfCoinstaller01000.dll,WdfCoInstaller"

[MyDevice_CoInstaller_CopyFiles]

WdfCoinstaller01000.dll

[SourceDisksFiles]

WdfCoinstaller01000.dll=1 ;
[MyDevice.NT.Wdf]

KmdfService = MyDevice, MyDevice_wdfsect

[MyDevice_wdfsect]

KmdfLibraryVersion = 1.0

Catalog Files and Digital Signatures

Because kernel-mode drivers have essentially unrestricted access to the system, they should be digitally signed. Digitally signing the package simplifies the installation process, but it also provides customers with two very important additional benefits:

· Customers can use the signature to identify the origin of the package.

· Customers can use the signature to verify that the contents of the package have not been tampered with since it was signed. For example, this assures them that the driver has not been modified into a rootkit or infected with a virus.

With recent versions of Windows, unsigned drivers can be installed only by an administrator, and even administrators receive a warning dialog box that requires them to explicitly approve the installation. The 64-bit version of the upcoming Windows Vista operating system does not allow unsigned drivers at all, except on test systems.

A signed catalog file (.cat) contains the digital signature for the entire driver package. The signing process ties the catalog file to a specific driver package. If anyone subsequently modifies any member of the package by even a single byte, it invalidates the signature. If you modify a driver package, it must have a new signed catalog file.

There are two ways to obtain a signed catalog file for a driver package:
· Obtain a Windows logo. Drivers that pass Windows Hardware Quality Lab (WHQL) testing and receive a Windows logo also receive a catalog file for the driver package, signed with the WHQL certificate. For further information, see the Windows Logo Web site.
· Create your own signed catalog file. You can obtain a digital certificate from a certificate authority (CA). The WDK provides tools to create a catalog file and sign it with the certificate. For further information on creating a signed catalog file, see the WDK documentation.
For testing purposes, you can create a test certificate and install it in the trusted publishers' certificates store on the test computer. Sign the test driver packages with the test certificate, and the driver will install without warning messages. For further information on creating and installing test certificates, see ”Kernel-Mode Code Signing Walkthrough” on the WHDC Web site.
The CatalogFile entry in the INF file's Version section specifies a packages catalog file. The following example is from the Featured Toaster sample's INF file and declares KmdfSamples.cat as the package's catalog file.
[Version]

Signature="$WINDOWS NT$"

Class=TOASTER

ClassGuid={B85B7C50-6A01-11d2-B841-00C04FAD5171}

Provider=%MSFT%

DriverVer=02/22/2006,1.0.0.0

CatalogFile=KmdfSamples.cat

Where to Install Featured Toaster

Kernel-mode drivers under development are normally installed on a separate test computer that is used specifically for testing and debugging drivers. If you are new to drivers, there are two primary reasons for this practice:
· Kernel-mode drivers have essentially unrestricted access to the system. This means that a misbehaving driver can corrupt system memory and possibly the contents of the hard disk. Drivers under development invariably have bugs, and it is better to have any related damage happen to a stripped-down test computer that can be easily reformatted.

· Debugging kernel-mode drivers normally requires two computers: one to host the driver being debugged and one to host the debugging software. One important reason for this arrangement is that driver bugs often hang or crash the system. Hosting the debugger on a separate system protects it from crashing along with the target computer and allows you to immediately analyze the problem.
How to Install Featured Toaster

This section describes how to install Featured Toaster on a test computer. The driver is installed on a root-enumerated physical device object, which is the simplest approach. More commonly, drivers are installed on a bus-enumerated physical device object. The Toaster sample also includes a bus driver that can be used for this type of installation. For details, see the documentation that is included with the sample.
Remember that Featured Toaster is a software driver, not a device driver. This means that there is nothing for the Plug and Play manager to detect, so the driver must be installed manually. Because the test driver is unsigned, installing it requires administrator rights and an extra step. For a more streamlined process, install a test certificate on the test computer and use the certificate to sign the package.
1.
Copy the driver binary (WdfFeatured.sys) and INF file (WdfFeatured.inf) to installable media such as a USB drive.

2.
Copy the WDF co‑installer to the same media.

3.
Put the media on the test computer, start the Control Panel Add Hardware wizard, and go to page 2.
4.
Page 2: Click Yes, I have already added the hardware.
5.
Page 3: Select Add a new hardware device, from the bottom of the list.

6.
Page 4: Click Install the hardware that I manually select from a list.

7.
Page 5: Select Show All Devices from the top of the list. It may take a while for page 6 to appear.
8.
Page 6: Click Have Disk, which opens the Install From a Disk dialog box.
9.
Enter the drive letter for the media that contains the driver package and click OK to return to the wizard.
10.
Page 8: Select the Featured Toaster driver from the list and click Next on this page and the following page. The system then loads the driver.

11.
Page 10: Click Finish to complete the process.

Device Manager is the simplest way to uninstall the driver. On Windows XP and later systems, you can also use System Restore to restore the system to the state it had before the driver installation. That uninstalls the driver, along with any other system changes that took place in the interim.

How to Test a KMDF Driver

Testing drivers is a large and complicated subject. This white paper touches on only a few KMDF-specific issues. On the WHDC Web site are several papers that go into various aspects of driver testing. There is also information on driver testing in the WDK documentation.

There are two basic approaches to testing:

· Static testing by uses tools that analyze the source code for errors without actually executing it.

· Dynamic testing that puts an installed driver through its paces in hopes of activating a bug and causing the driver to fail in some way.

Some related techniques, such as tracing tools, record the actions of a driver. This paper provides a brief introduction to the testing tools that WDF provides for KMDF drivers.

PREfast

PREfast is a static source code analysis tool that detects certain classes of errors not easily found by a compiler. PREfast steps through all possible execution paths in each function and evaluates each path for problems by simulating execution. PREfast does not actually execute code and cannot find all possible errors. However, it can find errors that the compiler might not catch and that can be difficult to find during debugging.

PREfast is a general-purpose tool that can be used with any type of project. WDF includes a customized version of PREfast that checks for driver-specific issues such as the correct interrupt request level (IRQL), use of preferred driver routines, and misuse of driver routines. It also aggressively checks for memory and resource leaks.

PREfast is run in conjunction with a build. The following is a simple example of how to run a PREfast build. For the purposes of illustration, the command uses a typical set of build flags, but any build flags can be used with PREfast. The second line opens the PREfast viewer to display the error log.
prefast build -ceZ
prefast view

For further information, see "PREfast with Driver-Specific Rules" on the WHDC Web site or the WDK documentation.

Static Driver Verifier

Static Driver Verifier (SDV) is a static compile-time unit-testing tool that symbolically executes the source code. SDV does deeper testing than PREfast and creates what is in effect a hostile environment for the driver. It systematically tests all code paths by looking for violations of usage rules. The symbolic execution makes very few assumptions about the state of the operating system or the initial state of the driver, so SDV can create scenarios that are difficult to handle with traditional testing.

Important  To take advantage of SDV when you develop KMDF drivers, you must use the edition of the WDK provided with Windows Server® Code Name "Longhorn" Beta 3 or later. For up-to-date information about SDV advances for Windows driver development, see “Static Driver Verifier” on the WHDC Web site.

The set of rules that are packaged with SDV define how device drivers should use the DDI. The categories of rules tested include the following.

	Category
	Tests

	IRP
	Functions that use I/O request packets

	IRQL
	Functions that use interrupt request levels

	PnP
	Functions that use Plug and Play

	PM
	Functions that use power management

	WMI
	Functions that use Windows Management Instrumentation

	Sync
	Functions that use synchronization, including spin locks, semaphores, timers, mutexes, and other methods of access control

	Other
	Functions that are not fully described by any of the other categories


For further information, see "Static Driver Verifier - Finding Driver Bugs at Compile-Time" on the WHDC Web site.
The KMDF Log

KMDF includes an internal trace logger that is based on the Windows software trace preprocessor (WPP). It tracks the progress of I/O request packets (IRPs) through the framework and the corresponding WDFREQUEST objects through the driver. The KMDF log maintains a record of recent trace events—currently, approximately the last 100—for each driver instance. Each KMDF driver has its own log.
You can use WDF debugger extensions to view and save the KMDF log during interactive debugging. The typical saved log file is small (10 to 20 KB) and written in a binary format. You can also make the logs available as part of a small-memory dump for inspection after a crash. For further information, see "How to Use the KMDF Log" on the WHDC Web site.
KMDF Verifier

KMDF Verifier operates on an installed and running driver. It complements Driver Verifier and supports a number of WDF-specific features. In addition, if the target driver is not loaded, KMDF Verifier can be turned on without rebooting the system. In general, you should run both Driver Verifier and KMDF Verifier during development.
KMDF verifier provides extensive tracing messages that supply detailed information about activities within the framework. It tracks references to each WDF object and builds a trace that can be sent to the debugger. In particular, KMDF Verifier:

· Checks lock acquisition and hierarchies.

· Ensures that calls to the framework occur at the correct IRQL.

· Verifies correct I/O cancellation and queue usage.

· Ensures that the driver and framework follow the documented contracts.

KMDF Verifier can also simulate low-memory and out-of-memory conditions. It tests a driver’s response to these situations to determine whether the driver responds properly without crashing, hanging, or failing to unload. For further information, see the "How to Enable the Frameworks Verifier" driver tip on the WHDC Web site.
How to Debug a KMDF Driver

Debuggers are an essential development tool; programs under development always have bugs, especially in the early stages. Debuggers can also be used as learning tools, to step through sample code and understand in detail how it functions.
Debugging is normally done at runtime to determine why a driver is failing. The exception to this rule is that kernel debuggers can also be used to analyze crash-dump files. If you are new to driver development, you will find kernel debugging a bit different from application debugging. One immediately noticeable difference is that kernel debugging requires three hardware components:

· A host computer running WinDbg. This is typically the computer that is used to develop and build the driver.
· A test computer running an appropriate build of Windows with the driver installed and kernel debugging enabled. Debugging is typically done with a checked build of the driver because checked builds are much easier to debug. Test computers also often run a checked build of Windows.
· A way for the two computers to communicate. Historically, this was handled by connecting serial ports on the host and test computers with a null-modem cable. An alternative is to use USB or IEEE 1394 cables.
The kernel debugging tools are available as a separate package from WHDC that includes the debugging tools, documentation, and some related files. For a link to the download site, see "Resources" at the end of this paper. The procedures for setting up systems for kernel debugging are covered in detail in the debugging documentation.
Note  In Windows Vista and later versions, most debugging tools—including WinDbg—must run with elevated privileges. The simplest way to do this is to right-click the WinDbg icon and click Run as administrator. All instructions to run WinDbg in this chapter assume that you will run WinDbg with elevated privileges in Windows Vista.

WinDbg
The debugging package includes two kernel debuggers, WinDbg and KD. They have essentially the same capabilities, but WinDbg has a graphical user interface (GUI) that many developers find convenient. The examples in this white paper are from WinDbg. The final section of this paper is a walkthrough of a simple debugging session with Featured Toaster that demonstrates the basics of how to use WinDbg with a KMDF driver.
WinDbg is a debugger, not an IDE like Visual Studio. It comes into play only after you have successfully built the driver and installed it on a test machine. There are two basic ways to use WinDbg:
· Kernel debugging. In this mode, WinDbg is connected to an active test machine and can interact with a running driver.
· Crash dump analysis. If the system crashes, you can use WinDbg to analyze the crash dump data to try to determine the cause.

When you launch WinDbg, you must first point it to the driver's source and symbol files. To start a kernel debugging session, on the File menu, click Kernel Debug. You won't be able to do much until the system breaks into the debugger. This essentially stops the test computer and turns its operation over to WinDbg. Three common ways to cause a test system to break into the debugger are:

· You instruct WinDbg to force a break.. 
This can be done from the UI, on the Debug menu by clicking Break, or by clicking the corresponding toolbar button. You can also run the break command.
· You use WinDbg to dynamically insert breakpoints into the running driver.

This approach is quite flexible because it allows breakpoints to be inserted, disabled, enabled, or removed during the debugging session. The procedure is discussed in the UMDF and KMDF walkthroughs later in this chapter.
· You insert DbgBreakPoint statements in the driver’s source code.
This approach is simpler but less flexible because the driver must be recompiled and reinstalled to change a breakpoint.
· The driver bug checks and crashes the test computer.
At this point, you can use WinDbg to examine crash dump data, but the computer must be rebooted before it can run again. You can force a system crash by running the .crash command.
The following is a screenshot of WinDbg with kernel debugging enabled.
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Kernel Debugging

With the first two cases in the previous section, after the driver breaks into the debugger, you can do most of the usual debugging procedures: examine variables, step through lines of source code, examine the call stack, and so on.
The preceding command window is where much of the work is done. The upper pane displays a variety of data, including the data that is generated by commands. The lower pane supports the same command-line interface as the KD debugger. You can use the mouse to highlight text from either pane or place a cursor in the command line, which is useful if you want to paste text into a command. For example, the data that is displayed by some commands includes suggested command line strings that retrieve related information. Just paste the string into the lower pane and run it to obtain the information.
Several other windows display a variety of information, including source code, local variables, disassembled code, and so on. For example, you can use the source code window to step through the source code.
Much of the interaction with WinDbg is through the command-line interface. There are two basic types of commands.
· Debugger commands are native to the debugger and are used to obtain basic information. Commands are typically one or two letter strings, often followed by one or more arguments. For example k and related commands display a thread's stack frame and some related information. When you are finished, use the g command to break out of the debugger and return the driver and test computer to normal operation. Some simple commands have corresponding menu items or toolbar buttons, but many can be run only from the command line.
· Debugger extensions extend the basic set of debugger commands. A number of them are included with the debugger package and are launched from the command window in much the same way as debugger commands. The first character of a debugger extension is always an exclamation point (!), to distinguish it from a debugger command. For example, a particularly useful debugger extension is !analyze, which is used to analyze crash dumps. In addition to the debugger extensions that are included with the debugger package, it is also possible to write custom debugger extensions.
The debugging Help file includes a complete reference for debugger commands, standard debugger extensions, and the API that is used to create custom extensions. "How to Debug KMDF Drivers," later in this paper, discusses some debugger extensions that were created specifically for KMDF drivers.
If a driver bug causes a system crash, the computer must be rebooted before it can run again. However, if WinDbg is running and connected when the test computer crashes, the system breaks into the debugger and you can analyze the crash dump immediately. You can also configure your test computer to attempt to create a crash dump file when it crashes. If the file is successfully created, you can load it into WinDbg and analyze the crash after the fact. WinDbg doesn't have to be connected to the test computer for this purpose.

How to Debug KMDF Drivers
Debugging a KMDF driver is similar in many ways to debugging any kernel-mode driver. However, some debugging features are specific to KMDF.
Registry Settings

A number of the WDF debugging features must be enabled by setting registry values for the driver's Parameters\Wdf subkey. The driver key itself is named for the driver and located under HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services.

The following table summarizes the values that can be added to the Wdf subkey. The features are disabled by a default. To enable most of these features, create the associated value and set it to a nonzero number. To enable handle tracking, set TrackHandles to a MULTI_SZ string that contains the names of the objects that you want to track. Note that the settings do not take effect until the next time that the driver is loaded. The simplest way to reload a driver is to use Device Manager to disable and then reenable the driver. For further information, see "How to Enable the Frameworks Verifier" on the WHDC Web site or the KMDF documentation.

	Category
	Type
	Tests

	VerifierOn
	REG_DWORD
	Set to a nonzero value to enable the KMDF verifier.

	VerifyOn
	
	Set to a nonzero value to enable the WDFVERIFY macro. If VerifierOn is set, WDFVERIFY is automatically enabled.

	DbgBreakOnError 
	REG_DWORD
	Set to a nonzero value to instruct the framework to break into the debugger when a driver calls WdfVerifierDbgBreakPoint.

	VerboseOn 
	REG_DWORD
	Set to a nonzero value to capture verbose information in the KMDF logger. 

	LogPages 
	REG_DWORD
	Set to a value from 1 to 10 to specify the number of memory pages that the framework assigns to its logger. The default value is 1.

	VerifierAllocateFailCount 
	REG_DWORD
	Set to a nonzero value to test low-memory conditions. When VerifierAllocateFailCount is set to n, the framework fails every attempt to allocate memory for the driver’s objects after the nth allocation. This value works only if VerifierOn is also set.

	TrackHandles
	MULTI_SZ
	Set to a MULTI_SZ string that contains the names of one or more object types to track handle references to those types. This feature can help find memory leaks that are caused by unreleased references. To track all object types, set TrackHandles to “*”. 

	ForceLogsInMiniDump
	REG_DWORD
	Set to a nonzero value to include the KMDF log in a small memory dump file if the system crashes.


Symbols
You must explicitly provide WinDbg with paths to all the relevant symbols files. For KMDF drivers, this normally includes the symbols for the driver, Windows, and the KMDF runtime. The symbols file is named Wdf01000.pdb and is located under %WDF_ROOT%\Symbols\Build Environment\wdf\sys. There are six Build Environment folders, one for each of the standard build types and architectures. For most debugging, you should use the checked build for the appropriate architecture. For a discussion of how to obtain symbols for Windows, see the debugging documentation.
Debugging Macros and Routines

KMDF drivers can include any of the standard debugging macros and routines, such as ASSERT or DbgPrintEx. Several routines and macros are also specific to WDF, as summarized in the following table. For details, see the KMDF documentation.

	Category
	Tests

	WdfVerifierDbgBreakPoint 
	This routine breaks into the debugger if the DbgBreakOnError value is set in the registry. 

	WDFVERIFY 
	If the VerifyOn value is set in the registry, this macro tests a logical expression and breaks into the kernel debugger if the expression evaluates to FALSE. Unlike ASSERT, this macro is included in both checked and free builds.

	VERIFY_IS_IRQL_PASSIVE_LEVEL 
	If the VerifyOn value is set in the registry, this macro breaks into the kernel debugger if the driver is not executing at IRQL = PASSIVE_LEVEL.


WDF Debugger Extension Commands

KMDF includes a set of debugger extension commands that can be invoked in the debugger's command window to obtain a variety of WDF-related data. The output often includes command strings that can be pasted into the command line to retrieve additional related information. The following table shows some of the more commonly used commands. For further information on KMDF debugging extensions, see "KMDF Debugging Extensions" on the WHDC Web site.
	Category
	Tests

	!wdfhelp
	Displays the list of debugger extensions.

	!wdfcrashdump 
	Displays a crash dump that includes the framework's log information. 

	!wdfdevice
	Displays information that is associated with a WDFDEVICE-typed handle. 

	!wdfdevicequeues
	Displays information about all the queue objects that belong to a specified device.

	!wdfdriverinfo
	Displays information about a framework-based driver, such as its runtime version and hierarchy of object handles.

	!wdfhandle
	Displays information about a specified KMDF handle.

	!wdfiotarget
	Displays information about a WDFIOTARGET-typed object handle.

	!wdfldr
	Displays all loaded WDF drivers.

	!wdflogdump
	Displays the framework's log information.

	!wdfqueue
	Displays information about a WDFQUEUE-typed object handle.

	!wdfrequest
	Displays information about a WDFREQUEST-typed object handle.


When KMDF Verifier is enabled, several of the WDF debugger extension commands provide more information than is available otherwise. For example, !wdfdriverinfo reports leaked handles.
The code for the WDF debugger extensions is contained in a DLL that is named wdfkd.dll. The DLL is included with WDK debugging tools and is stored in Program Files\Debugging Tools for Windows\winext. Check it against the most recent version of the DLL, which is included with the latest KMDF distribution. Wdfkd.dll is stored under WinDDK\BuildNumber\bin\. There are actually three versions of wdfkd.dll, one for each supported architecture (amd64, Intel Itanium, or x86). If necessary, overwrite the version that came with the debugger with the most recent version.
How to Use WPP Tracing with a KMDF Driver

WPP tracing works in essentially the same way with a KMDF driver as it does with a WDM driver. However, KMDF provides hundreds of framework-specific tracing messages. To enable KMDF support for WPP, include the following RUN_WPP directive in the project's Sources file.

RUN_WPP = $(SOURCES)                             \

          -km                                    \

          -func:TraceEvents(LEVEL,FLAGS,MSG,...) \

          -gen:{km-WdfDefault.tpl}*.tmh
For more information on WPP tracing, see “Getting Started with Software Tracing in Windows Drivers”  on the WHDC Web site.
How to Use WinDbg with Featured Toaster

Featured Toaster doesn't have any known bugs, but WinDbg is still a useful tool to walk through the source and see how the driver works. The walkthrough also demonstrates the basics of how to use WinDbg.

The test computer should be running Windows with kernel debugging enabled and be connected to the host computer. For convenience, this paper, assumes that the COM ports are connected with a null-modem cable.
The simplest way to use the debugger is to run a test application that accesses the driver and hits a breakpoint, causing the driver to break into the debugger. KMDF doesn't include test applications for Toaster, but the WDM test application, Toast.exe, works just as well with the KMDF version of the driver.

The source code for Toast.exe is located at WinDDK\BuildNumber\src\general\toaster\exe\toast. Use the same console window and build commands to build Toast.exe as for Featured Toaster. Note that unlike most projects, the output folder is not a subfolder of the project folder. Copy Toast.exe from the output folder WinDDK\BuildNumber\src\general\toaster\disk\chk_wxp_x86\i386 to a convenient folder on the test computer.
To get WinDbg ready to debug Featured Toaster:
1.
Launch WinDbg.

2.
On the File menu, click Symbol File Path, which causes the Symbols Search Path dialog box to appear. It should have paths for the Featured Toaster, Windows, KMDF runtime, and wdfkd.dll symbols files.

3.
Select the Reload check box, which forces WinDbg to load the current symbols, and close the dialog box.

4.
On the File menu, click Source File Path, and add the path to the Featured Toaster's source files.

5.
On the File menu, click Open Source File. Open Featured Toaster's Toaster.c file.

6.
On the File menu, click Kernel Debug. This puts WinDbg into kernel debugging mode and establishes the connection with the test computer.

7.
Enter the appropriate baud rate and COM port in the Kernel Debugging dialog box, and click OK to start the debugging session.

8
On the Debug menu, click Break, which forces a break and allows you to run debugging commands.
9.
Use the bp command as follows to set a breakpoint in Featured Toaster's ToasterEvtIoRead routine.
bp ToasterEvtIoRead
To start debugging:

1.
Go to the test computer, launch a command window, and run Toast.exe. Type any character other than "q" to cause Toast.exe to send a read request to the driver. Toast.exe then calls Featured Toaster's ToasterEvtIoRead routine. When the driver hits the breakpoint, it breaks into the debugger.
2.
On the Debug menu, select the Source Mode check box if it isn't already selected. This mode allows you to step through the source code. Notice that the corresponding assembler appears in the Command window. Even if you never write a line of assembler, it's still useful to know something about it for debugging purposes.

3.
Set the cursor on a line of source code. On the Debug menu, click Run to Cursor. The selected line should be highlighted in blue.

4.
On the Debug menu, click Step Over to execute the next line. There's also a Toolbar button for this purpose, located underneath the Window menu.
To get detailed information, call one of the debugger extensions. One useful WDF debugger extension is !wdfdriverinfo, which returns general information about the driver. It takes the name of the driver as a required argument plus a flag that controls exactly what data is returned. 0xF0 returns essentially everything. The following example shows the output from !wdfdriverinfo for Featured Toaster.
kd> !wdfdriverinfo wdffeatured 0xf0

----------------------------------

Default driver image name:   wdffeatured

WDF runtime image name:      Wdf01000

 FxDriverGlobals  0x829a3c80

 WdfBindInfo      0xf7991b8c

   Version        v1.0 build(1234)

Driver Handles:

WDFDRIVER 0x7d6494f8  dt FxDriver 0x829b6b00

    WDFDEVICE 0x7d4e1588  dt FxDevice 0x82b1ea70 Context 82b1ec30 Cleanup f7992dc0

        WDF INTERNAL   dt FxDefaultIrpHandler 0x82aca158

        WDF INTERNAL   dt FxPkgGeneral 0x829e8160

        WDF INTERNAL   dt FxWmiIrpHandler 0x82aa8cb0

        WDF INTERNAL   dt FxPkgIo 0x82b1cef0

            WDFQUEUE 0x7d4e1250  dt FxIoQueue 0x82b1eda8

            WDFQUEUE 0x7d552720  dt FxIoQueue 0x82aad8d8

        WDF INTERNAL   dt FxPkgFdo 0x82aa9d50

        WDFCMRESLIST 0x7d4e6340  dt FxCmResList 0x82b19cb8

        WDFCMRESLIST 0x7d4e1e10  dt FxCmResList 0x82b1e1e8

        WDFCHILDLIST 0x7d639ba8  dt FxChildList 0x829c6450

        WDFIOTARGET 0x7d6462d8  dt FxIoTarget 0x829b9d20

        WDF INTERNAL   dt FxWmiProvider 0x829b6698

            WDF INTERNAL   dt FxWmiInstanceExternal 0x82b1e098

        WDFWMIPROVIDER 0x7d644088  dt FxWmiProvider 0x829bbf70

            WDFWMIINSTANCE 0x7d560080  dt FxWmiInstanceExternal 0x82a9ff78 Context 82a9ffe8

        WDFWMIPROVIDER 0x7d6436d0  dt FxWmiProvider 0x829bc928

            WDFWMIINSTANCE 0x7d550d78  dt FxWmiInstanceExternal 0x82aaf280

        WDFWMIPROVIDER 0x7d6432a8  dt FxWmiProvider 0x829bcd50

            WDFWMIINSTANCE 0x7d5295e0  dt FxWmiInstanceExternal 0x82ad6a18 Context 82ad6a88

        WDFFILEOBJECT 0x7d4edc18  dt FxFileObject 0x82b123e0

Many debugger commands and extensions require a handle to an object. For example, !wdfrequest takes a WDFREQUEST object handle and returns information about the object. To get such a handle, on the View menu, click Locals. Assuming that the debugger is still in the ToasterEvtIoRead routine, the associated WDFREQUEST object is named Request. The handle appears in the corresponding Value field in the Locals window. The following example shows the output from this command. Paste the commands from lines two or three to the command line to obtain related information.

kd> !wdfrequest 0x7d627768

   !IRP 0x829ff008

   !WDFQUEUE 0x7d552720

   State:  Pending, Allocated by WDF for incoming IRP

From this point, you should be able to continue on your own. There are a variety of other features to try, such as watch windows and a window that displays the call stack. They work in much the same way as the corresponding features in a user-mode debugger.
Resources

This section provides links to resources for driver development in general and WDF in particular.

General

How to Get the Windows Driver Kit (WDK) and the Windows Logo Kit (WLK)
http://www.microsoft.com/whdc/DevTools/WDK/WDKpkg.mspx
Windows Hardware Development Central

http://www.microsoft.com/whdc/default.mspx
Driver Installation

http://www.microsoft.com/whdc/driver/install/default.mspx
Debugging Tools for Windows - Overview

http://www.microsoft.com/whdc/DevTools/Debugging/default.mspx
Install Debugging Tools for Windows 32-bit Version

http://www.microsoft.com/whdc/devtools/debugging/installx86.mspx
Windows Logo Program and Driver Signing: Overview
http://www.microsoft.com/whdc/winlogo/default.mspx
Kernel-Mode Code Signing Walkthrough
http://www.microsoft.com/whdc/winlogo/drvsign/kmcs_walkthrough.mspx
Cryptography Tools
http://msdn2.microsoft.com/en-us/library/aa380259.aspx
Driver Signing Requirements for Windows
http://www.microsoft.com/whdc/winlogo/drvsign/drvsign.mspx
Digital Signatures for Kernel Modules on Systems Running Windows Vista 
http://www.microsoft.com/whdc/system/platform/64bit/kmsigning.mspx
PREfast with Driver-Specific Rules

http://www.microsoft.com/whdc/devtools/tools/PREfast-drv.mspx
Microsoft Hardware Newsletter

http://www.microsoft.com/whdc/resources/news/default.mspx
Static Driver Verifier - Finding Driver Bugs at Compile-Time
http://go.microsoft.com/fwlink/?LinkId=80082
OSR Online

http://www.osronline.com/
Getting Started with Software Tracing in Windows Drivers
http://www.microsoft.com/whdc/DevTools/tools/WPP_Intro.mspx
WDF

Introduction to Kernel-Mode Driver Development for Application Developers
http://www.microsoft.com/whdc/driver/wdf/KMintro_appdevs.mspx
Windows Driver Foundation (WDF)
http://www.microsoft.com/whdc/driver/wdf/default.mspx
Introduction to the Windows Driver Foundation

http://www.microsoft.com/whdc/driver/wdf/wdf-intro.mspx
Architecture of the Windows Driver Foundation

http://www.microsoft.com/whdc/driver/wdf/wdf-arch.mspx
WDF Driver Verification Tools

http://www.microsoft.com/whdc/driver/wdf/Drv-VerTools.mspx
Static Driver Verifier - Finding Driver Bugs at Compile-Time

http://www.microsoft.com/whdc/devtools/tools/sdv.mspx
KMDF

How to Enable the Frameworks Verifier

http://www.microsoft.com/whdc/driver/tips/KMDFVerifier.mspx
How to Use the KMDF Log

http://www.microsoft.com/whdc/driver/tips/KMDF_IfrLog.mspx
Kernel-Mode Driver Framework (KMDF)
http://www.microsoft.com/whdc/driver/wdf/KMDF.mspx
Architecture of the Kernel-Mode Driver Framework

http://www.microsoft.com/whdc/driver/wdf/KMDF-arch.mspx
Sample Drivers for the Kernel Mode Driver Framework

http://www.microsoft.com/whdc/driver/wdf/KMDF-samp.mspx
Kernel-Mode Driver Framework (download page)
http://www.microsoft.com/whdc/driver/wdf/KMDF_pkg.mspx
KMDF Debugging Extensions

http://www.microsoft.com/whdc/driver/wdf/KMDF-dbgext.mspx
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